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Introduction

Thank you for selecting GeoJournal to plan, manage, and record your Geocaching adventures. GeoJournal
was written by Rich Martin after discovering the sport and then realizing there were no good Mac
applications for Geocache management. I also realized that a lot of the fun of Geocaching is recording the
experience in both written and visual form, and no application allowed you to do that. With that in mind, I
set forth in writing GeoJournal. GeoJournal is the best Mac application of it's kind, and I hope that you find
it useful and enjoyable.

Rich Martin, Geolngenuity
Author of GeoJournal
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Getting Started

Application Layout

There are three basic areas of the GeoJournal application layout. The first area is the "Cache Listing" area
where all the geocaches that have been imported are listed. This area has a header on the top of each column
that can be clicked and the list will be re-sorted according to that column. The second area of the
application is the "Details" area, where further details of the currently selected geocache are displayed. The
third area is the "Controls" section, where various buttons are located that can be used to act on the
currently selected geocache. It should not take long for you to become familiar with the layout of
GeoJournal and how to interact with it.

Setting Your Preferences

After you start GeoJournal for the first time, it is important to set your Preferences. The Preferences menu
can be found by clicking "GeoJournal" in the menu bar, and then clicking on Preferences. You could also
type in the shortcut key combination of "Command+," to bring up the Preferences screen.



General Tab

e Display coordinates as - Select the method you would like your coordinates displayed in GeoJournal.
Most applications express coordinates in the "Degrees Decimal Minutes" format (default), but you can
change to the other formats as needed. Check "Use N, E, S, W Instead of +/-" if you would like to express
coordinates directionally.

e Check for updates online when first started - This option will connect to the GeoJournal update server on
startup to check if there's a new version of the application. If so, a pop up message will inform you of the
new version.

e Show finds in Geocache list - If a geocache is marked as Found, it normally will not show up in the main
geocache listing, and instead be categorized in the "My Finds" category. If checked, "Found" geocaches will
appear in the main listing.

e Geocache name is bold if it has a picture - If a geocache item has a picture linked to it in the Journal tab,
it will appear with a bold font in the geocache list. This allows you to easily identify items with pictures that
you may want to go back and look at.

e Load map automatically when highlighted - If a geocache is selected in the list, the map for the geocache
is loaded automatically. If not checked, you will need to click the "Geocache" button in the Maps section on
the left side of the main window to load the geocache's map.

GPS Tab

e GPS Manufacturer - Select your GPS receiver's manufacturer from the drop-down list. If your
manufacturer is not listed, please contact us with your GPSr's make and model, and we will try to support it
if possible. You can use the link under Help -> Feedback to send us an email.

e GPS model - Select your GPS receiver's model. If your model is not listed, you may try to select a similar
model to see if it works. Many models share the same communication protocol and will work even if it's a
different name.

e [nterface - Select the type of interface your GPS receiver uses. If your GPSr uses a standard serial
interface, usually a 9 or 25 pin cable that connects to the device, choose this option and select the serial port
from the drop-down box. If you are using a USB to Serial Port device (i.e. Keyspan, Belkin, and others)
then please have your USB device plugged in first, or it may not show up in the drop down box.

If your GPSr shows up as a USB Storage device, select the USB Storage: option. If you are unsure, plug
your GPSr into your Mac. If a drive icon appears on your desktop and acts like a mounted drive, then it is a
USB Storage type device. If your device appears as a USB storage device, please input it's Volume name
when it is mounted. (When it is plugged in, what name shows up under the white drive icon?)

Select USB if your device communicates directly via USB, but does NOT use a serial port interface and
does NOT appear as a USB storage device. Most current Garmin devices are direct USB and should be used
with this option.

Appearance Tab

e Details area background color - Click the color box to change the background color. Click the Set to
Default button to change the color back to the 'blackish' default background color.

e Details area text color - Click the color box to change the text color. Click the Set to Default button to
change the color back to the 'greenish' default text color.



Advanced Tab

e Database is backed up on startup - Normally, GeoJournal will back up your database each time you start
the application. Up to 5 different database backups are saved. This process is done immediately when you
start the application. If you have another backup procedure, you may disable this feature.

e Use shortnames when exporting waypoints - Instead of using the geocache ids on your GPS receiver (i.e.
GCWXY?Z), the application will generate a unique shortname based on the geocache's name to give more
description on the GPS reciever.

e FEvent duration for .ics export - When exporting your "Found" geocaches to Apple iCal, each geocache is
saved as an event. In iCal, each event has a duration, and this option allows you to select the default event
duration.

e Double clicking on a geocache - Define the action to take when you double click a geocache from the
cache list. Default is to do nothing.

Importing Geocaches

In order to use GeoJournal, it will be necessary to import Geocaches from a source. Typically Geocaches
from from either a LOC or GPX file from the geocaching.com web site. LOC files can be obtained from
free from geocaching.com and contain very basic geocache information, usually the cache name,
coordinates. GPX files are also obtained from geocaching.com, but contain all the information and details
for geocaches. GPX files can only be generated with a premium membership at geocaching.com. In order to
use GeoJournal to it's fullest, it is highly recommended that you purchase a premium membership at
geocaching.com and generate your own GPX files with the "Pocket Query" feature. Regardless of which
kind of file you use, GeoJournal supports each format seamlessly.

Toolbar: File » Import From...
e Click the Browse button and navigate and select the GPX or LOC file that you wish to import.

e The "Import into" drop-down box specifies a category to import the geocaches into. You may select an
existing category from the drop-down, or you may TYPE in a new category in this box and it will be
created automatically. More information on Categories in the next section.

e Check the "Import all as Found" if you are importing a file that contains all the geocaches you have
already found. If you are a premium geocaching.com member, you can generate a GPX file with all your
finds once a week.

e Click Start to import, or Cancel to exit without importing anything.

e The importing process will determine if a cache you are importing already exists in the database. If so, it
will detect if the new geocache information has been updated and if so, it will update it in the database.
Otherwise, it will skipped. Drag & Drop Importing

e In addition to manually importing, you may also drag and drop a GPX or LOC file directly into the
GeoJournal icon in the Mac OS X Dock or into the cache listing area of the application.

Understanding Locations

In GeoJournal, your Location is the origin point used to calculate distances to the caches in the list. You can



think of it as your Home point. However, sometimes you aren't starting from the same place. Most
Geocachers like to cache in other cities, states, and countries so it makes sense to have more than 1 Location
point, right? Well, GeoJournal can do exactly that! GeoJournal allows you to create a list of Locations,
input thier coordinates, and select them as you need them and distances are automatically recalculated in the
cache list.

Creating a new Location
e In the cache list area, click the "+" button to the right of the Location drop-down.

e The Location manager window will open. You can highlight an existing Location and click the Edit
button to edit it.

e Click the New button to create a new Location. Give it a descriptive name, and enter it's Latitude and
Longitude coordinates. Please express these coordinates in Degrees Decimal Minutes notation with + and -.
If you need help converting from a different format, click on the Convert button.

e Click the Set Default button to select this Location as the default each time GeoJournal is launched.

e If you no longer need a Location entry, highlight it and click the Delete button to remove it from the list
e Click Save to save your changes or Cancel to exit without saving.

Changing Locations

e From the main cache listing, select a new Location from the drop down box.
e Notice that the distance field in the cache list automatically updates itself.

Understanding Categories

In GeoJournal, geocaches can be grouped together in any way you decide. For instance, you may want to
group together geocaches in a certain geographic region. Or perhaps you would like to group together
geocaches based on their type. GeoJournal gives you the flexibility to group geocaches any way you wish by
creating an almost unlimited list of Categories. Once you create a Category, you can assign geocaches in the
list to those Categories. You can then quickly sort the list of caches by your defined Categories.

Creating a new Category
e In the cache list area, click the "+" button to the right of the Category drop-down.

e The Category manager window will open. You can highlight an existing Category and click the Edit
button to edit it.

e Click the New button to create a new Category. Give it a descriptive name that will make sense to you
when you see it later.

e If you no longer need a Category entry, highlight it and click the Delete button to remove it from the list
e Click Save to save your changes or Cancel to exit without saving.

Changing Categories



e By selecting a category from the drop-down box, the cache listing will automatically filter the list and
show you only the caches that belong to that Category.

e There are certain Categories that exist by default. The are: "All Geocaches", "My Finds", and "Default".
All Geocaches will always contain every geocache in the database, regardless of it's categorization. My
Finds will list only those Geocaches that you have marked as Found in the application. Default is a default
Category and isn't special except that it cannot be deleted. Think of it as a place to store your caches until
you have a Category you want to place them in.
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Using GeoJournal

Cache Listing Area

The Cache Listing contains a list of the current filtered geocaches that you have in your database. It is
separated into different columns. These columns can be clicked on to sort the entire cache list. The cache
list is filtered based on the current Category selected. By selecting a different Category, only those
geocaches that are part of the Category are listed in the cache listing. The exception is the "All Geocaches'
category, which always includes all current Geocaches. By selecting a different Location, the Distance
column is automatically updated with new distances from the new Location.

Cache listing columns

e Cache Name - The name given to the geocache, if clicked it will be sorted alphabetically.

e Type - The type of geocache (Multi, Traditional, Virtual, etc), if clicked it will be sorted alphabetically.
e Size - Size of the geocache (Micro, Small, Regular, Large, etc), if clicked it will be sorted alphabetically.
e TB - The number of TravelBugs that are currently in the cache, if clicked it will be sorted numerically.

e Difficulty - Cache difficulty rating, 1 (low difficulty) to 5 (very difficult), if clicked it will be sorted
numerically.

e Terrain - Cache terrain rating, 1 (easy terrain) to 5 (very hard terrain), if clicked it will be sorted
numerically.

e State - State which this geocache is located, if clicked it will be sorted alphabetically.
e Placed - Date that this geocache was placed on, if clicked it will be sorted by date.
e Found - If you found it, it will be set to Yes, otherwise No. if clicked it will be sorted alphabetically.

e Dist - Distance from the currently selected Location. Calculation is an estimate based on a straight line
between the Location and the Geocache coordinates, and does not reflect distance based on road travel, if
clicked it will be sorted numerically.

e Dir - General direction of the geocache from the currently selected Location, if clicked it will be sorted



alphabetically.
Searching the cache list
e To search through the cache list, enter a text string in the "Find" area and click the "Find" button.

e The search will look for the text string within the CACHE NAME field, and will stop and highlight the
first match it finds.

e Click "Find" again to continue searching for the next instance.

e Searching begins at the currently selected cache and continues down.

e When the end of the list is found, you will be notified and can continue the search from the top of the list.
e Click the "x" button next to the Find text field to clear the text and reset the search.

Categorizing Geocaches

Once you have Categories created, select the Geocaches in the list that you would like to categorize. You
can select them one at a time by holding down Command and clicking, drag selecting, or Selecting the first
cache holding down Shift and clicking the last cache to select them all in between.

e Click the "Move" button on the left, and it will open a Move dialog.

e Select your Category from the drop-down list -OR- type in the name of a new Category and it will be
created on the fly.

e Click Move to move the selected caches or Cancel to exit without moving anything.
Deleting Geocaches

This will permanently remove geocache(s) from your cache list.

e Select the geocaches that you wish to delete.

e Click the Delete button in the Control area. You will be given a chance to cancel to delete in the next
dialog.

View as Web page

This will open your browser to the cache's web page on geocaching.com.
e Select a Geocache from the list.

e Click the View as Web Page button from the control list.

Send to GPS

This option will send the currently selected geocaches to your connected GPS device. Please make sure that
your GPS receiver is properly connected to your Mac, and that it is configured correctly under Preferences.

e Select one or multiple Geocaches from the list.



e Click the "Send to GPS" button from the control list and the Send dialog will open.

e Choose whether you want to send only the Selected geocaches to your GPS or the entire Category.
e Depending on the GPS type, there may be additional options to set.

e Click Start to send or cancel to exit.

Add as Location

This is useful if you are using GeoJournal while you are caching, and you find a cache and want to know
what the next nearest cache is at.

e Select a Geocache from the list.
e Click the Add as Location button from the control list. This will add the selected geocache to your
Location list by copying it's name and coordinates.

Add to Itinerary

This will add the currently selected geocaches to the itinerary. More information on itineraries later in this
section.

e Select one or multiple Geocaches from the cache list.

e Click the "Add to Itinerary" button in the control area and the caches will show up in the itinerary listing.

Details Area

The Details areas is where you can get all the additional information about the currently selected geocache.
Where the cache list gives you the basic information, the Details area gives you all the information currently
available about the selected Geocache. GeoJournal puts all of this information in a simple, easy to use
interface.

Details Tab

The details tab contains lots of detailed information about the selected cache. On the right side, there are 11
fields of information

e Status - Status of the cache. May be Available, offline, etc.

Difficulty - Difficulty of the cache 1 to 5

Terrain - Terrain of the cache 1 to 5

Placed on - Date that this cache was initially placed.

Placed by - The geocaching.com user that placed this cache.

Cache Type - Type of cache this is, Traditional, virtual, etc.

Cache Size - Size of the cache container.



State - State that this cache resides.

Country - The Country that this cacher resides.

Latitude - Latitude coordinates of the cache, expressed in the format based in Preferences.

Longitude - Longitude coordinates of the cache, expressed in the format based in Preferences.
Tabbed Area

The tabbed area to the right contains even more information on the geocache. Click on the tabs at the top to
view the information pertaining to that tab.

e Description Tab - Contains the cache's description, created by the owner of the geocache.
e Cache Logs - Contains the cache's logs, created by users who have attempted to find the cache.

e Travelbugs - Contains a list of the Travelbugs that are currently in this cache. Click on the bullet (dot) to
the left of the Travel bug name to open it's web page on geocaching.com

e Hints - Contains any hints left by the owner of this geocache. Use with caution! :)

Maps Tab

The Maps tab is a unique feature to GeoJournal compared to other Geocaching management applications.
GeoJournal imbeds a web browser in the application and can automatically present a view of the selected
geocache's location by using Google Maps.

e Select a geocache from the cache list.
e Click on the "Maps" tab and the application will query the GeoJournal servers and pull map data from
Google Maps.

e If you are familiar with Google Maps, all the same controls are available. You can drag the map around or
click on the Satellite or Hybrid buttons to change the view.

e Click the + and - buttons to zoom in and out of the map.

Itinerary Tab

The Itinerary tab is another unique feature that GeoJournal offers. In a nutshell, it allows you to create a list
of Geocaches that you would like to find, and automatically sort them based on distance. It also allows you
to modify the sorting based on your needs. If you have Google Earth installed, you can view the cache
itinerary on the Google Earth maps to visually verify the order. You can load and save the itinerary for use
later OR you can export the itinarary to a text file that can be printed or put on a PDA for paperless
caching! Brilliant, no? ;-)

e To add caches to the itinerary, select caches from the cache list and click the "Add to Itinerary" button.
The caches will be placed in the itinerary list.

e Click the "Sort Itinerary" button to sort the caches based on distance. Make sure that your Location is set
to the one you want, because the initial distance calculation is based on the current Location.



e The itinerary list will be sorted and updated with the current distance and direction from the previous
cache.

e Click on Google Earth to launch that application and view your itinerary. This is a good time to verify
that the route is what you want. If you decide that you want to modify the route, you can do so.

e To modify the order, you will use the "Lock" feature. The "Lock" feature allows you to lock in a specific
cache in a certain order in the list. When the "Sort Itinerary" button is clicked, any Locked items will not be
re-ordered. Instead, the order is calculated with the locked item in it's place.

e Select an item in the list. You can move it up and down in the list by clicking the up and down buttons on
the right.

e When you are happy with the order, you can lock the item by clicking the Lock check box. The item is
now locked.

e Click "Sort Itinerary" and the itinerary will be ordered "around" any locked items in the list.

e Click the Export... button to save the itinerary as a text file on your Desktop. This is perfect for printing
out or putting on a PDA. Select the fields that you want to appear in the text file within the export dialog.

e In case you want to see the details of a Cache in the itinerary list, select it and click the "Locate" button.
This will highlight the cache in the cache list, and thus populate all the detail fields so you can view them by
selecting the Details tab.

e As a convenience, you can click the "Move" button to move all the caches in the itinerary to a specific
Category.

e Finally, you can save the current itinerary by typing in a name and clicking the Save button. To load,
highlight the itinerary name from the drop-down box and click Load.

Journal Tab

The Journal Tab is the great feature that GeoJournal is named after! Many times the real fun of geocaching
isn't just finding the cache, but the journey in getting there. A lot of funny and memorable things happen
during geocaching adventures, and GeoJournal allows you to keep those memories intact! The Journal area
gives you the ability to mark a cache as found, create a Journal entry to describe the adventure you had at
the cache, and an area to link pictures you may have taken while searching for this cache!

The Found button

After selecting a cache from the list, click on the "Found" button to mark this cache as found by you. The
date and time fields will automatically populate. You may modify/correct them as necessary. Clicking
Found again will mark it as not found.

The Journal Area
Immediately below the Found button is a text area where you can describe your adventure for this geocache.

This is your Journal area, so make sure you write in as many details as you can remember. Trust me, you
will be glad you did later! Any text entered here is automatically saved.



Pictures

To the left of the Journal is an area to add pictures that you may have taken at this cache. To add a picture,
you can drag and drop one into the window, or click the "+" button and a dialog will open up. Click the
Browse button to find the picture. Create a cute caption for the picture as well and click Add to add it to the
Journal. NOTE: A link to the picture is all that is saved! This means that if the picture is deleted or moved
from it's original location, GeoJournal will not be able to find it again. It is recommended that you drag and
drop from iPhoto into GeoJournal.

Click the "-" button to delete the current picture. If you want to change the caption, simply click on it and a
dialog will open that will allow you to change it. Use the > and < buttons to view the previous and next
pictures in the list. Finally, click the "View" button to view a full size version of the picture in Preview.
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Advanced Features

POP3 Mail Import

If you are premium subscriber to geocaching.com, you have the ability to generate Pocket Queries. Pocket
Queries are a list of geocaches created based on your search criteria. These files are usually large GPX
formatted text files. Pocket Queries are emailed to you and can be zipped (compressed) to save space.
GeoJournal has the ability to import these files directly from the application, saving you the hassle of
downloading them to your Mac, unzipping them, and then importing them into your application.
Additionally, GeoJournal will remember which Pocket Queries it has already downloaded, and skip
importing of those. Also, you can create very powerful automated rules in GeoJournal that will
automatically import a zipped Pocket Query and place it into the proper category so that all you need to do
is click a single button and everything is downloaded, imported, and categorized every time!

To access the POP3 feature, click on Tools -> POP3 Mail on the toolbar, or use the shortcut Command+P.
Configuration Tab

Go to the Configuration Tab to set up your POP3 account. Note-- At this time, GeoJournal only supports
standard cleartext (unencrypted) POP3 access to your account. Some mail services (i.e. Google Mail) only
provide encrypted POP3 access which is not compatible with GeoJournal. Supporting encrypted POP3 mail
accounts is a possible feature for an upcoming version of GeoJournal.

POP3 Server
Enter the hostname or IP address of your mail server in this field.
Port

Enter the tcp port of the POP3 service. Most standard implementations of POP3 use port 110 so it is advised
to use the default (110) if you are unsure. If you know the port has been relocated, you may enter it here.

POP3 Account

Enter your POP3 account or username here. In some cases, it is the same as your email address (i.e.



yourname @domain.com) or sometimes, it is your email but the at sign (@) is replaced with a dot (.) as in
yourname.domain.com. Finally, it may just be your email name without the domain (yourname in this
example). If you are unsure, contact your mail support person to find out.

POP3 Password
Enter your POP3 account's password.
FROM field matches

In this area, you may enter a text string that will filter the email listing results and only show emails that
match. For instance, most Pocket Queries generated by geocaching.com are sent from the user
"contact@geocaching.com". If you have many different emails in your POP3 account, you will see all your
emails in GeoJournal, but you are only interested in the ones from geocaching.com. If you enter
"geocaching.com" (without the quotes) in this field, GeoJournal will filter out any emails that are not from
geocaching.com and you will only see those matching email in your list.

Save Settings
This button will save all of your POP3 configuration settings to the database.
Test Settings

Click this button to test your current settings. If your settings are correct, you will see a "Login Successful"
window. If there is a problem with your settings, you should see a window with an error description. If you
are seeing errors without a known error, check that your POP3 Server is correct, and that you are currently

connected to the Internet.

Disconnect

Click the disconnect button to completely disconnect from the POP3 server. If you are having any issues
with logging into the POP3 server, click the Disconnect button and try again. This will reset the connection
and may resolve your issues.

Check Email Tab

After setting up your POP3 settings successfully, click on the Check Email tab to bring up a list of emails in
your mailbox. From here you can manage your email, import attachments in one at a time, and build
powerful rules to automate all your Pocket Query imports. Check Mail Button

Click this button and GeoJournal will log into your POP3 account and download the current list of emails.
This could take some time, depending on your connection speed and number of emails. It is highly
recommended that you create a separate email account solely for your geocachiing Pocket Queries. Once the
process completes, you should have a list of all the emails in your account.

Set Category

Select an email with a Pocket Query attachment. Notice that by default, the Import Category field shows the
Default category. Use the drop-down box next to the Set Category button to change the category that this
Query will be imported into. As always, you can select an existing category from the drop-down, or you can
type a new category name in the field. Click the Set Category button to make the change. You will see that



the Import Category entry is update with the new Category. This change is NOT permanent, but is intended
to be used as you need it. To save this entry, please refer to the "Add to Import Rules" button description
below.

Add to Import Rules

Once you've selected an email to import and set it's Category, you may want to save this as a Rule for
subsequent importing. By clicking this button, this rule will be added to the "Import Rules" section. Please
note, that this does NOT save your rule, as that must be done in the Import Rules area (refer to that section
in this documentation). Instead, this will simply transfer the rule to the Import Rules area.

View Message
Select an email and click this button to see a brief output of the body of the message.
Delete Message

Clicking this button will delete the currently highlighted message. This will PERMANENTLY delete it
from the server-- be warned.

Import Attachment

Clicking this button will immediately import the currently selected email's attachment and import the file
using the Category specified in the list (by default it will be the Default Category).

Import Rules Tab

The Import Rules Tab is where you can automate the process of downloading GPX files from your POP3
account and automatically place them into specific categories based on the file name. The import rules area
builds upon rules transferred from the Check Email tab or rules created from this area. Any rules transferred
by clicking the "Add to Import Rules" button on the "Check Email" tab should show up in this list. Add
Rule button

This button allows you to create a new import rule from scratch. Most of the time, you will probably create
rules from the Check Email area, but if you know the attachment name, you can use this feature to create
your own rule. The Rule Name should be a descriptive name for you to remember the rule by. The
Attachment name is the name given to the attachment by the geocaching.com site. The Import Category is
the category you would like the caches in the file to be imported into. A category that doesn't exist will be
created automatically. The "Found?" checkbox will mark ALL the geocaches in this attachment as being
Found by you. It will be given a found date and time of the time of importing into the application. The
"Active" checkbox allows you to activate or deactivate a rule without deleting it. If Active is checked, the
rule will be evaluated, if it is not checked then the rule will be skipped. The "Last Import Date" field shows
you when this file was last successfully imported.

Edit Rule button

This button will allow you to Edit the currently selected Rule. See the field descriptions above for their
explanations.

Remove Rule button



Clicking this button will remove the current rule from the Rule list. The change is not permanent unless the
Save Rules button is clicked, however if the Import button is clicked, the rule will not be evaluated since it
is not in the current list. If the application is restarted without saving, the removed rule will be seen again.

Clear Date button

Click this button to clear the "Last Import Date". Once a file has been imported, GeoJournal will remember
that and skip it if you try to import it again. If you wish to force it to import the attachment, use the Clear
Date button to clear it's last import. The next time you import, the attachment will be included, as the
application sees it as a new file that has never been imported before.

Save Rules button

This button will save the current rules to the database. Any time the POP3 window is opened, the currently
saved rules are loaded into the Import Rules window.

Load Rules button

This button will load the currently saved rules into the window. It is useful if you have manually edited or
created rules, but wish to reload the existing rules and not save the ones you made.

Import button

Once your rules are created, click the Import button to make it all happen. The Import will connect to the
POP3 server, and go through each email looking for a Pocket Query attachment. Once found, it will look at
the file name and evaluate it based on your current rules. If a match is found, it determines if it has already
been previously imported. If so, it will be skipped. If not, it will be automatically imported into the Category
specified. A current count of the emails and thier status is shown below the Import button. OK is the count
of emails that were successfully imported. Skipped is the count of emails that had matching rules, but were
skipped because they were previously imported. No Rule is the count of emails that appear to be valid
pocket query files, but were not imported because there was not a rule for them. Not Active is the count of
emails that were ignored and not imported because thier associated rule was deactivated (the Active
checkbox was not checked).

Advanced Exporting

GeoJournal support exporting selected geocaches into different data formats and applications. This
flexibility allows you to integrate your GeoJournal managed data into other applications. All export formats
are accessed by first selecting the cache or group of caches from the main Cache list. Once you have them
selected, click on File -> Export selected to... on the Toolbar.

GPX Export

This option will allow you to export the selected caches as a GPX file. A GPX file is an XML formatted
text file with information specific to geocaching. The GPX format is the basic format used by most
Geocaching applications. This file will be created on your Desktop, and should be usable in any application
that supports the GPX file format.

GPS Receiver

This option is the same as clicking the "Send to GPS" button. This feature is covered in Chapter 3, "Using



GeoJournal".
Apple iCal

This feature will export all your found geocaches into an iCal compatible file which can be imported into
Apple's 1Cal calendar application, which is a standard application installed with Mac OS X. Once the file is
created, simply import it from iCal and create a new category name. You will see all of your "Finds" now in
iCal on the date that you found them. They will also include a link to the cache's website, and any Journal
text you have are displayed in the Notes area of iCal. When exporting, GeoJournal only exports Found
caches that are new since the last export. If you wish to export all of them again, uncheck the "Only export
new finds" check box on the export dialog and then click the Export button.

CacheMate

GeoJournal supports exporting selected geocaches to a CacheMate compatible PDB file. CacheMate is an
application that runs on both Palm Pilot and Windows Mobile based PDAs. CacheMate is used by many
Geocachers for "Paperless" geocaching. This export feature will create a CacheMate PDB file that can be
transferred to a Palm Pilot and imported into CacheMate. This is handy for creating a list of geocaches that
you would like to accomplish. Note-- The PDB files are compatible with the PALM PILOT version of
CacheMate. If you have the Windows Mobile version of CacheMate, you can export your selected caches as
a GPX file, and use that file to import into Windows Mobile CacheMate.

Google Earth

This feature will export the currently selected caches and open thier locations up within Google Earth.
Google Earth is a fantastically cool free application that will let you see each cache on a map. Google Earth
needs to be previously installed for this option to work.

Advanced Selecting

The Advanced Selecting features refer to the options available under Edit -> Advanced on the GeoJournal
toolbar. These options normally work on the currently selected geocache(s) in the main Cache list.

Edit

The Edit option will allow you to edit the currently selected Geocache. You can edit most of the details of
the cache from here. If you have multiple caches selected, you will only edit the top most cache entry.

Move

The Move option will allow you to change the category of the currently selected Geocaches. You will be
prompted for the new Category from a drop-down box. You can select an existing Category from the drop-
down. If you type in a new Category in the drop-down area, the Category will be created on the fly.

Delete

The Delete option will delete all of the currently selected geocaches. You will be prompted after you select
this option to be sure you want to delete the group of caches.

Database features



The database features are accessed from Tools -> Database from the GeoJournal Toolbar.
Optimize

This feature will optimize the current GeoJournal database. If you have many additions and deletions of
geocaches within the application, it may be advisable to run the optimize command occasionally. This will
optimize the database and remove any unused entries in the database. It will also reduce the file size of the
database if it can. This process will not remove any valid data from your database. In some cases, this will
also improve the performance of the database searching and the application in general (typically for very,
very large databases with lots of geocache entries).

Restore

The Restore feature should be used WITH CAUTION. Every time GeoJournal starts up, it creates a back up
of the current database (unless this option is turned off in preferences). Up to 5 database back ups are
created. You may wish to restore a previous database from the list. BE WARNED-- If you restore a
previous database, all changes in the current database will be lost permanently. This feature gives you the
ability to recover from a previous database in case your current one becomes corrupted. Also, if you happen
to delete caches that you did not want to, you can restore from the last previous database to recover to
where your last database state was. The databases are listed in order of oldest first on the list. Please pay
attention to the dates and file size of the databases before you Restore one. If you wish to restore, select the
database you want to restore, click the restore button, and cross your fingers! You have been warned... :)
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Licensing and Limitations

End User License Agreement

The product is protected by Federal Copyright Law. ABSOLUTE INGENTUITY, INC. retains the title to
and ownership of the Product. You are licensed to use this Product on the following terms and conditions:

LICENSE - The licensee is defined as the individual or company utilizing the Software Product.
ABSOLUTE INGENUITY, INC. hereby grants the licensee a nonexclusive license authorizing the licensee
to use the enclosed Product on one computer at a time. Please contact ABSOLUTE INGENUITY, INC. if
you require additional licenses. Use of this product by more than one individual or by anyone other than the
licensee terminates, without notification, this license and the right to use this product.

YOU MAY NOT: Distribute, rent, sub-license or otherwise make available to others the software or
documentation or copies thereof, except as expressly permitted in this License without prior written consent
from ABSOLUTE INGENUITY, INC. In the case of an authorized transfer, the transferee must agree to be
bound by the terms and conditions of this License Agreement.

RESTRICTIONS - You may use this Product in your business as long as: The software serial number and
user must be registered with ABSOLUTE INGENUITY, INC. in order to receive support or distribution
rights. You may not remove any proprietary notices, labels, trademarks on the software or documentation.
You may not modify, de-compile, disassemble, reverse engineer or translate the software.



US GOVERNMENT RESTRICTED RIGHTS - Use, duplication or disclosure by the United States
Government is subject to restrictions as set forth under DFARS 252.227-7013 or in FARS 52.227-19
Commercial Computer Software - Restricted Rights.

TERM - You may terminate your License and this Agreement at anytime by destroying all copies of the
Product and Product Documentation. They will also terminate automatically if you fail to comply with any
term or condition in this Agreement.

LIMITED WARRANTY - This software and documentation are sold "as is" without any warranty as to
their performance, merchantability or fitness for any particular purpose. The licensee assumes the entire risk
as to the quality and performance of the software. In no event shall ABSOLUTE INGENUITY, INC. or
anyone else who has been involved in the creation, development, production, or delivery of this software be
liable for any direct, incidental or consequential damages, such as, but not limited to, loss of anticipated
profits, benefits, use, or data resulting from the use of this software, or arising out of any breach of
warranty.

EXCLUSIONS - External programs and works bundled with this application do so with the permission of
thier authors and according to thier individual Licensing agreements. This Licensing agreement does not
apply to those included works. Please refer to thier individual Licensing agreements for terms and
conditions of thier use. For more information on these works, please contact support@ geojournal.net.

Demo Period

When initially installed, GeoJournal operates in a full demo mode. You are allowed unrestricted access to
the application for a period of 30 days. This period is to allow you to fully test drive the application and it's
features and evaluate it's usefulness to you. Please take the opportunity to do that. At the end of the 30 day
evaluation period, we hope that you decide to purchase a permanent license for GeoJournal. By purchasing a
license, you are entitled to upgrades for this version of the application. Upgrades will include bug fixes and
exciting new features. Licensed users will also be given priority support via email, and the ability to
generate feature requests that may be implemented to improve the application. If you decide to not purchase
GeoJournal, you may still use GeoJournal, but you will be constantly reminded to purchase a license for the
application. Also, you will lose access to POP3 import and possibly other advanced features. Also, the maps
will not automatically load when a cache is selected-- you will have to manually click the Geocache button
under the Maps section in order to load the Google Map.

Acceptable Licensing Usage

Your purchase of a GeoJournal license entitles you to run GeoJournal on a single Mac computer. If you
have several accounts on a single computer, it is permissible to allow multiple users to use the GeoJournal
application. Each user will have their own personal database created with their own caches and settings. It is
also permissible for you to install GeoJournal on more that 1 computer if the SAME user is accessing the
application. For instance, you may wish to run GeoJournal on both your Laptop and Desktop. If the owner
of both systems is the same person, and if they are the only user using both installed applications, this is a
permissible scenario for licensing.

If you wish to run GeoJournal on multiple computers for DIFFERENT users, you will need to buy a license
for each computer with a different user. There are no checks for multiple versions being installed, so we
work on the honor system that you will operate within the license framework of this application.

If you have any questions about licensing, please feel free to contact us via the Feedback mechanism in the



GeoJournal application. Please title the Subject as Licensing or similar.

Final Thoughts from the Author

I sincerely hope that if you like the application that you purchase a license for it. Unless you are involved
with software development, you may not understand the hours and hours of time spent to write even the
most basic of programs. GeoJournal is no exception. It is the work hours and hours of programming,
troubleshooting, and planning over the course of 6 months with absolutely no guarantee of it's success. In
many ways, independent software development is a labor of love and a sacrifice time. In GeoJournal's case,
there is also a matter of resources that are used when the application is used. Every query to load a Google
Map in GeoJournal is sent to my server. From there, my server queries Google Maps directly and sends the
response back to you. This is done because Google's licensing requires it before any web application can use
their awesome mapping service. However, in order to bring you this feature, I must pay for a co-located
server capable of handling those requests. This is an ongoing cost that must be paid, and so your purchase
helps to continue to directly support the application. In the future, it may be necessary to block all map
requests from any non-registered application in order to keep costs down for this resource. We hope that
this will not happen.

Thank you for choosing GeoJournal.
-Rich Martin, GeoJournal Author
Owner Geolngenuity/Absolute Ingenuity, Inc.
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Technical Notes

This area is for explaining technical details of GeoJournal that may interest more advanced users. Topics
will be added as they are uncovered.

Backing up GeoJournal data manually

GeoJournal gives you the option of disabling the automatic backup of it's databases under it's preferences
area. Normally, this is not suggested, however, there are scenarios where you may not want to have the
automatic backups run. If your existing hard drive is already being incrementally backed up by another
application, it may not be necessary to have an in-application backup run. Also, with the upcoming release
of Leopard, the Time Machine feature may also negate the need for a backup. GeoJournal stores it's
database under "~/Application Support/Geo Journal/" where ~ is your currently logged in user's home
directory. You may wish to manually back up this directory with another application and disable the in-
application backup. Or you may want to keep it enabled as another layer of protection against database
corruption/hard drive failure.
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Credits



I would like to recognize the following people and organizations for their contributions to this work:

GeoJournal utilizes GPSBabel to communicate with a variety of different GPS receivers. GPSBabel is an open-source project headed
by Robert Lipe. For every GeoJournal license that is purchased, a donation will be made to the GPSBabel project. You can visit their
website and donate directly at www.gpsbabel.org.

GeoJournal utilizes a utility called CMConvert, which converts geocache data into files that are compatible with CacheMate for
paperless Geocaching. CMConvert is used with permission by the author. Please visit his website for more information:
www.smittyware.com.

The stand-along open-source applications used by GeoJournal include code licensed under the GNU General Public License. You can
read about the GPL at http://www.gnu.org/licenses/gpl-fag.html.

GeoJournal includes, with permission, a PDF brochure about Geocaching. The brochure is accessible under the Help menu of the
application. This brochure was written and developed by Brett Hammond. Please visit his web site at www.geocacher-u.com for
more great information on Geocaching.

GeoJournal utilizes maps through it's built-in web browser via the Google Maps API. As part of the terms and conditions to use the
API, all map requests in GeoJournal are sent through a Geolngenuity server and the map data is routed back to the application. You
can access this site directly at www.geojournal.net/gj/maps/googlemap.html. Google maps API documentation is available at

wWww.google.com/apis/maps.

GeoJournal can integrate with Google Earth for the Mac. Google Earth is a free program by Google. You can download the
application at earth.google.com.

Icons "lurker" and "radar" that are used in this application are from the freely availble icon sets created by Cain Walsh. You can visit
his website at www.afterglow.ie.

The Geolngenuity "Lightbulb Earth" Icon was created by Nick Onken. I want to also thank Nick for all his hard work in beta testing
GeoJournal, and for providing lots and lots of Feedback and feature requests for the application. He is also responsible for writing a
lot of the online documentation. Nick runs a personal website at chimbisimo.googlepages.com dedicated to helping Mac Geocachers
cope in a Windows world...

I want to thank my wife Jennifer and my 2 kids for their love, time, and support.

Last, but certainly not least, I would like to thank God.
"All things are possible to him who believes." - Mark 9:23
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